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OVERVIEW 

The DSI-1550 system quickly enable the user to discover that there are many other ways to 

operate the system to accomplish a particular task, some of which bypass steps and 

accelerate operations.  

 

System Description 

The DSI-1550 RF Measurement System is designed to fully utilize the capabilities of the 

R-1550 receiver to accurately measure signals using a variety of sensors and measurement 

methods. The system software provides for: 

 

Definition and correction of sensors � 

� Creation of tests  

� Set-up of the system hardware  

� Sweep testing  

� Interactive control of the receiver (Interactive Mode)  

� Automated recording of manual receiver settings and signals (Data-log Mode)  

� Preparation of hard copy outputs.  

 

The R-1560 System Interface unit helps to simplify the operation and periodic calibration 

of the system by allowing multiple input devices to be defined as part of the system and 

automatically selected by the software when required without further operator involvement. 

The system operates through the use of Windows "screens". These screens provide a 

powerful human interface to facilitate full utilization of the system's capabilities. There is a 

set of primary screens; from these, secondary screens and "dialog boxes" are activated. 

When the system is turned-on, the first screen to appear is the Main screen; from it the 

other screens can be selected.  
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System Implementation 

Knowledge of system signal flow paths is helpful in understanding how to fully utilize the 

DSI-1550 System. There are two sets of RF ports. The ports are selectable manually or via 

the computer. The amplitude of the selected input signal is controlled with the receiver's 

input attenuator. It, and all of the other receiver controls, can be manually operated or 

remotely controlled. The signal is then sent to one of the receiver's three RF circuits or 

"bands". The band is automatically selected internally by the tuned frequency. The circuits 

in each band amplify, condition, and convert the incoming RF signal to a 21.4MHz IF 

signal for further processing in the receiver's IF section. At this point in the path the IF 

signal has a maximum bandwidth of approximately 20MHz. A portion of this IF signal is 

tappedoff and called the "Signal Monitor" because it provides a convenient point for 

monitoring all of the RF signals entering the receiver around the tuned frequency. The 

optional R-110-40A Panoramic Display can be attached to the Signal Monitor port to view 

the spectrum within ±5MHz of the tuned frequency. The receiver's IF section provides 

bandpass filtering and amplification of the IF signal. A large number of bandwidths are 

provided to facilitate investigation of both CW and impulsive signals. The "DCIF" is a 

variable filter module, which provides the narrow bandwidths up to 20kHz. Noise filtering 
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is automatically provided to insure signal quality. A portion of the final IF signal is tapped 

and provided at the rear the receiver for use in special applications. The output of the IF 

section is peak detected or FM demodulated, depending on the detection mode selected. 

The resulting video is supplied to a peak-hold and conversion circuit (DVM) which 

captures and digitizes peak signals at all bandwidth settings. The receiver's analog video 

signal is supplied in three separate forms: the main output on the front panel; the auxiliary 

output on the front panel; and the Z-axis on the rear panel. The auxiliary output has pulse 

stretch and slideback controls to facilitate signal examination, and the Z-axis has both level 

and inversion controls making it well suited to drive CRT guns for observation of raster 

signals.  

 

The R-1560 contains two Impulse Generators available as a precise reference for periodic 

calibration of the system. Each IG is a solid state RF impulse generator covering the 

frequency range of 100Hz to 1GHz. 1IG is chassis isolated to function as a low frequency 

source the other IG is used for high frequencies. Either IG will provide impulses at 

repetition rates and amplitudes selected by front panel controls or via the IEEE-488 bus. 

The R-1560 features an uncomplicated front panel with discrete LED displays to indicate 

the pulse repetition rate and the actual output amplitude in dBuV/ MHz, referenced to 50Ω. 

Provision is made for pulses to be triggered by an adjustable internal time base (manually, 

externally, or by the AC line). Pulse repetition rate and amplitude may also be programmed 

via the IEEE-488 interface bus. The R-1560 also provides both low and high frequency 

input ports which are available for antenna or other signal source connections which can be 

automatically selected by the system software as required by programmed tests. 

 

SWEEP TESTING 
The DSI-1550 system can be used for a variety of measurement tasks. The following 

example, showing how a sweep test is performed, illustrates many of the techniques and 

processes available. In this example, the user: 

1. Configures the system 

2. Defines sensors and hard-copy equipment 

3. Sets up the test by establishing sweep test parameters and limit lines 
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4. Performs the sweep test 

5. Interrupts the sweep to interactively investigate signals 

6. Manually controls the receiver to further investigate signals and uses data-log feature to 

record information 

7. Completes the sweep test 

8. Prepares hard-copy results The Main Screen is the starting point for the process.  

 

The Main Screen has a Menu Bar, various "buttons", and a block diagram showing the 

system configuration. While the sweep test can be initiated by clicking on the Sweep button 

and performing the set-up operations from the Sweep Test screen, it is a bit more "orderly" 

to set-up the configuration and the sweep test parameters first 

 

 

 

 Configuration 

The block diagram on the Main Screen shows the last-used system configuration, this 

configuration must be adjusted by the user to reflect the present or desired set-up. Clicking 

on the Receiver Configuration on the entry screen will bring up the setup screen. The 

setup screen dialog is used to select the receiver inputs and show how they are configured 

with the R-1560. First select a port to which the connection will be made by clicking on the 

circle to the left of the port. Then select the appropriate sensor or Signal Generator from the 

pull-down list. Various antennas, other sensors, and signal generators can be selected for 
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the receiver's signal sources. A cable may also be selected if you want the correction factor 

to be applied. If the desired sensor or cable has not been defined.  

 

When a new sensor is used, it must be defined. In general, sensors require correction tables 

to yield accurate measurements, and correction data must be entered. By clicking on the 

Main screen's Correction Factors button. The Edit Correction Factors screen appears. 

The default screen has two entries: 100Hz and 18GHz. These can be edited or deleted by 

highlighting and selecting one of the "Point" buttons. Additional points can be added and 

then edited. If another correction line table is similar to the one required for the new sensor, 

it can be recalled and edited, using the File pull-down and selecting Open to find the file. 

All correction line table files have a ".cf or .cl" extension. By pulling down the 

Configuration menu and clicking on Transducer the Edit Transducer List dialog will 

appear. Existing transducers are shown and can be edited. To add a new transducer click on 

Add and the Edit Transducer dialog will appear. Fill out the table, then select the related 

correction line files to be applied by highlighting the selected .CF file in the left column 

and then click on Apply. The list of applied files appears in the right column.  

 

 Signal Sources 

The Configuration pull-down menu permits definition of signal sources (i.e. signal 

generators and impulse generators) as well as transducers. When a signal source is used as 

an input device, the system automatically controls the device's operation during sweep 

testing. Clicking on Signal Source in the menu brings up the Define Input Device dialog.. 

 

Other Configuration Functions 

The Configuration pull-down menu includes other entries: Directories: selecting 

Directories brings up the Directory Configuration dialog which specifies the DOS paths for 

each of the file types used by the system, these may be changed by the user to suit special 

installation requirements. When enabled in a sweep, a front-end overload will adjust the 

attenuator setting and this setting will not be decreased until the end of a segment. Cal 

Table Stat: brings up a screen containing a summary of the current calibration data 

showing the date when the data was taken. 
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Set-up of the Test 

Set-up of the test from the Main screen is accomplished by clicking on the Sweep 

Parameters button or by using the Edit pulldown and selecting Sweep Parameters. Setup 

can also be accomplished or changed after the Sweep test is activated. 

 

Sweep Test Parameters 

When Sweep Parameters is selected the Edit Sweep Parameters dialog will appear. The 

sweep can be conducted in any number of segments (including a single segment). Each 

vertical column represents a segment of the sweep. More segments can be added by 

clicking on the Segment Add button, and segments can be inserted or deleted. A previously 

created set of parameters can be recalled using the File pull-down and selecting Open. The 

test files all have the extension ".stp" or ".tp". Clicking on New brings up the default set of 

parameters. These can be edited to create the desired test conditions. 

 

Limit Lines 

Limit lines for a user defined sweep test are prepared by clicking on the Limit Line button 

on the Main screen. The Edit Limit Line dialog appears. The process for their creation and 

editing is identical to that described previously for Correction Factors, except that files are 

automatically saved with an ".ll" extension. 

 

 Interactive Mode 
The Interactive Mode can be initiated by clicking on the Interactive button during a sweep 

test, or directly from the Main screen, since it is not necessary to be sweep testing to use the 

mode. When the mode is active, the Interactive Test screen is present. It is similar to the 

sweep screen, but the receiver controls are now active. A square cursor shows the receiver's 

tuned frequency and the signal amplitude. The frequency can be changed, the frequency 

can be set by typing a new value. The frequency may also be adjusted by single clicking on 

the frequency box to highlight it. The step size can be changed by selecting the value; the 

arrows make decade adjustments, while the + and - buttons change the reading by a factor 

of 2. Bandwidth, attenuation, gain, can be adjusted in a similar fashion. The spectrum can 
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be scanned using the controls at the lower left. The "Up" and Down" define the direction of 

the scan, while "Dwell" holds at the current frequency. The "Pen Down" causes the data to 

be plotted on the screen. In the lower right corner of the screen the receiver Status is 

displayed, as follows: 

FROL Front-end overload 

BKOL Back-end (detector) overload 

FRUL Front-end underload 

LOCK Synthesizer is not locked  

A powerful feature of the Interactive mode is the ability to re-scale the graph range. 

Pulldown Display, and select Change Plot Parameters. Enter the start and stop frequencies 

on the screen for the desired range. If the receiver is currently tuned outside of the new 

range, the system sill automatically re-tune the receiver to put it in the specified range. 

 

Datalog Mode 
The Datalog mode makes its possible to examine signals in more detail, which may have 

been at, or near the limit line during a sweep test. If a limit-crossing mode is selected (one 

of three types of lists under the key GEN LIST) the operator will have the opportunity to 

specify an offset from the limit in order to accommodate measurement uncertainties. A list 

of frequencies where the measurement was above the limit will be automatically generated 

and inserted in the datalog table. The operator may examine the time domain signal 

information at the Receiver Video Output using an oscilloscope. Make measurements by 

comparing the amplitude to a standard signal source (signal, or impulse generator), which 

travels exactly the same signal path through the receiver, and log the measurement in one 

of four categories, i.e., Data Related, Unrelated, Compromising and Noise. In the upper 

                                                                 Dynamic Sciences international Inc 



right hand screen the selected signal source conditions are displayed.  The up-down arrows 

control the signal amplitude and percent of modulation within the allowable parameters of 

the selected device. Any device may be selected which has previously been defined as part 

of the system. On the right center of the screen are displayed the current selections for input 

source to the receiver, and the device selected for comparison measurements. The selection 

box to the left of each input device allows the operator to toggle between the devices to 

compare measurement results. Each device travels the same signal path in the receiver. On 

the left center of the screen are the frequency and bandwidth displays for the receiver. 

While the antenna input is selected, the displays are active and the receiver frequency and 

bandwidth may be entered directly into the boxes, or the receiver may be tuned manually. 

The ADD key will cause the new selections to be entered into the datalog table. Each data 

type to be recorded has a measurement value box with a record button below. When the 

record button is selected, the signal generator value is recorded for that measurement type. 

the operator can enter a value directly. After all of the values have been recorded in the 

datalog table the operator may choose to sort the table in either ascending or descending 

order based on any value recorded in the table. Comments, or test conditions may also be 

recorded in the associated field for any table entry. The measurements are collected in a 

buffer. The buffer can be stored for future use. Previously saved files can be recalled to 

load the buffer, and then used to set the receiver controls to repeat previous measurements. 

Previously acquired and inserted data can be read and used to return the receiver to the 

associated settings. If a data-logging file is recalled, the user must insure the configuration 

is consistent with the hardware set-up that was previously utilized for the test. Selecting 

RECORD will add this information to the log as a new data point. As many conditions as 

desired may be entered at a given frequency for measurement of video information. 
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When data logging is completed the temporary file may be permanently stored. The Data-

logging dialog screen presents the following information: 

1. Frequency: the manually-tuned frequency of the receiver or of the downconverter. 

2. Bandwidth: the bandwidth control setting. 

3. DRE: data related emission value 

4. URE: not data related value 

5. CE: compromising emission value 

6. NOISE: noise related value 

7. LIMIT: limit at the specified frequency.  

8. DELTA: amount over the limit line for that measurement 

All data related to the measurement is stored in the datalog file 

 

Broad/ Narrowband Determination 
Clicking on the Broad/Narrowband Determination box changes the display to indicate 

the characteristics of signals in the plot.  

All of the narrowband signals are marked on the plot and a list is generated. Broadband and 

narrowband limit lines can be opened; when this is done the narrowband exceedances are 

noted on the list and a separate broadband list is created. 

 

Broad and Narrow Band 
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Tabular Reports 

In addition to graphical reports, parameter summaries, data log files, limit line exceedances, 

and the narrowband list can be printed by first using the File pull-down and then clicking 

on Open Data-log to select the file. Select Print and click on the appropriate box in the 

dialog. 

 

 Printing 

Various print options are provided by Print. Printing is initiated using the Print button on 

the screen or by using the File pull-down menu. The Print dialog has different report types 

available, and the output can be directed to a printer, plotter, or file. 

 

Stack Reports 

The Stack Reports mode, selected from the Main Screen, permits background outputting 

of hard-copy results. The Hardcopy Output screen appears when this mode is selected; 

this screen allows selection of test result files from the default directory, other hard disk 

locations, or from the floppy drive. Controls are included for selection of the number of 

copies, orientation (portrait or landscape), and the order, which the outputs are. 
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Specifications 
SYSTEM 

Measurement Precision: 

For SNR>10 dB, 4 dB (uncalibrated), 

 2 dB with calibration sources 

Sensitivity: 

Typically 6 dB above Johnson noise 

RECEIVER 

Noise Figure: 

Less than 13 dB (10dB typ. in mid-range) 

IF and Image Rejection: 

At least 80 dB 

Spur-free Dynamic Range: 

Better than 60dB 

Frequency Stability: 

1 ppm per year 

Autoranging: 

Selectable - uses 100dB 10dB step attenuator/ 

receiver gain in 1dB steps 

Frequency Range: 

100Hz to 1 GHz (extendable to 22GHz with 

the R-1580 Microwave Downconverter) 

Input Attenuator: 

0-100 dB in 10 dB steps 

IF Bandwidths: 

35 BW from 50 Hz to 200 MHz 

1:2:5 sequence 

Detection Modes: 

AM/FM/CW 

DVM: 

Peak-hold, 100 MHz BW, 12 bit A/D, 4-digit 

DVM display and LED BAR 

IF Output: 

1450 MHz, 21.4 MHz 

Video Outputs: 

AM (peak) and FM, Linear/Log, Aux video 

with pulse stretch/slidebac

Audio: 

>1 Vrms; + 3 dB, 20 Hz-20 kHz 

Power: 

120 watts 115/230 50 or 60 Hz 

Mechanical: 

Receiver has side handles and collapsible feet 

(front); rack mount kit available. 

Weight: 

44 lb. (20 kg) 

Power: 100 Watts typical 

15/230V 50 or 60 Hz 

SOFTWARE 

Operating System: 

DOS 7.0 

Environment: 

Windows 3.1x, 95/98/00, NT4.0 

Application: 

DSI A-1550 Version 1.0 

RECEIVER SYSTEM CONNECTIONS 

RF Input Connectors: 50ΩType N Signal In 

Type N Calibrate In 

Type BNC Signal In (Low Freq.) 
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Type BNC Calibrate In (Low Freq.) 

Video/IF: 

BNC, 50Ω  

Instrumentation: 

GPIB IEEE-488.2 bus 

1560 SYSTEM INTERFACE CONNECTIONS 

RF Connectors: 50Ω 

5-Each Type N High Frequency 

5-Each Type N Low Frequency (isolated) 

Instrumentation: 

GPIB IEEE-488.2 bus 

Impulse Generator: 

BNC Sync. Out 

BNC External Trigger Input 

Weight: 25 lbs (11.4 kg) 

Power: 75 Watts Typical 

 

COMPUTER 

Processor: 

Pentium or equivalent 

CPU Speed: 

700 MHz (3min) 

 

RAM: 

128 M-byte (min) 

Hard-disk: 

20 GB (min) 

Floppy Drive: 

1.44 MB 

 

CD ROM: 

24X (min) 

Display: 

SVGA/VESA 640x480 

Input: 

Mouse, 101 keyboard 

Expansion: 

2 ISA, 2PCI (min) 

Weight: 

20 lbs (9 kg) 

Power: 

100 watts typical 

115/230 50 or 60 Hz
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